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Guide — Indoor Climate
Purpose

This is the first part of the IDA ICE basic course 1, where you get started with the IDA ICE standard
level. You learn how to perform an indoor climate (or comfort) analysis of a room. During this guided
exercise, we go through the following tasks:

e Start a new project

e Definiton of the comfort relevant objects in a zone: Windows, ventilation, heaters,
coolers, internal loads and controller setpoints.

e Using the suitable zone model (called ”Climate” or "Energy”)

e Setting up and running a heat load calculation

e Setting up and running a cooling load calculation

e Reading the result tables

e Looking at important zone result diagrams

To get more support, also use the getting started guide, accessible over the "Help” menue within the
IDA ICE software.

Background

To evaluate the thermal room comfort is an important element of many certification systems as
Miljébyggnad in Sweden, DGNB in Germany or Minergie in Switzerland.
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Instructions

Step 1

There are different ways of starting a new simulation project. In the menu bar you can find the three
2N

buttons ﬁ, and “4 ., The first button opens a new IDA ICE model without any default input. The

second one opens a new IDA ICE model with all default values that are required for being able to run

a simulation (including one single zone). The third button opens a new IDA ESBO model. Depending

on the localization of IDA ICE, there might be more buttons to start a new IDA ICE model from local

building templates.

Not all available building templates are represented in a button on the menu bar. To get the
complete selection of building templates, use the command ”File” > "New” to open the "New
document” dialog as shown below. With deeper knowledge of the IDA ICE software, it is possible to
create your own customized building templates.

@ New document ﬁ
IDAApplication

——

Auxiliary

[ cancel |

Help

Template

n
[ SlABestandGeb
[ SlIAStandardGeb
[ SIAZielGeb
[ Empty
-~ |DA Room Wizard
© Advanced level only system
Resource container -

m

a. Select "Building” from the "New document” dialog and click “OK”. This has the same effect as

clicking on in the menu bar. From the table in the lower half of the General tab, you find
that one zone representing a single room (called "Zone”) is inserted to your new simulation
model (the table has one row per zone). From the same table, you can also find the most
important predefined properties of the zone. By selecting other tables than “Zones”, you can
choose what model properties you want to look at.

b. Save your model by selecting "File” > ”Save as...” and rename the model to ”IndClim-MyEx"”
or any other suitable name and save it in a suitable place.
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”n ” n H ” H H H
a. Select "Zone totals”, "Zone setpoints” etc. to study the properties of different objects of your
model:
77 building2: building2.idm = EoR ==
General loc-CH | Fioor pian| 3D | Simulation | Daylight | Outiine | Summary | Details
Project [ building2 O Puoject data
Global Data .+ HVAC Systems - Energy Meters Usage
& Location £ Defaults & Air Handling Unit A\ Lighting, facility =
Kalmar = (7 Site shading and orientation @ Plant A\ Lighting, tenant
B A\ Equipment, facility
» Thermal bridges
Climate =4 Thermal br A\ Eguipment, tenant
[Default] Kalmar-1968 = @ Ground properties ‘A Electric coaling r
 nfiltration A Fuel cooling
* Wind Profile M\ District cooling
© [Default urban] [=]» [S)Pressure AJGAHU. M HVAC aux
Holidays # Exira enerqy and losses Replace A Electric heating
<value not set> v M System parameters i nirol § R Fuel heating
[<value not set> =] R — -
Details [®Reoon A Expand table
I Zones @ Zone totals Zone setpoints Surfaces ‘Windows Internal gains Wall constructions Time schedules Materials Room units Energy meters Air handling units
| MWalls | Mwalls
Floor Zone M*Area, | M*Supply | M*Return |M*Occupal M*Lights, | M*Lights, | M*Equip | M*Equip |M*Volume) M*Extwin |M*Extdoor] M*Roof |M*Ground| M*floor to
Name | S Ineigntm|mutipher| m2 | airUs | air s rIts.\lu;n# Woy |, | ment |mentjum  m3 “":fz“" "E'g"’z“" area,m2 | area m21 area, m2 | area. m2 | amb., m2
[Elzone 0.0 1 10.0 200 1500 (13140 260 50 00 0.0 0.0 0.0 0.0
Total 1 10,0 200 200 10 50.0 4380 1500 13140 260 50 0.0 15 00 00 00 00

Go to the Floor plan tab and check the zone @ (representing a room) and the building body

@. At the moment, our zone is situated at the southern facade of the building body (see
north arrow at top left of the building body).

You can either mark the zone or the building body by clicking on them. The properties of the
marked object are shown in the side bar &. The side bar can always be opened and closed by
clicking on [ in the menu bar @.

W byt 15 o et e o G 4.5 gl m e Ol g e s ox
£t Yon ot Doos Opors Window te
D-F-E-8 thBloc NS 0P M@-8 Db av Ofas (4]
[Formims o @ i ” EE]
o General Fioorpian 3D Simuation Daylght Oubine Summary Detats
Grn el
® 240 [25 |
w[on a0
efoo 25 |
Al g
foom & o.ceiling
e
W —20m B
Fos [100 m2 ‘ 9}
Zove 280 m3 !
Gornare i,
i arigin.
I
00 40
Zas a0
T2 oo
00 o
Elogen zome l w2
* 5
ewrne [y e wo Leex anew tmervom
Buldng bocy 26.087m -B.42m

Note: All main geometrical modelling is done in the Floor plan tab. We will show much more of this

in another lesson.
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c. Dragand drop the zone till the southwest corner of the building body.

By doing this, use the following features:

e Snap: When you drag the zone towards the corner of the building body, you can stop
near the place you want the zone, but not exactly on it. You will then observe how
the dragged object is snapped to other lines/objects. For this, you need to come
quite close to the other object. By pressing the Shift-key, you will get help in dragging
your object only in x- or y-direction.

e Lock: You find the T -button in the bottom right of the Floor plan view. After
clicking here, you can lock the objects you finished working with. Like this you can
protect these objects against unintentional moving or resizing.

d. Open the zone form by double clicking on it. In the zone form you find an overview over all
properties of the zone. In this lesson, we will concentrate on windows, ventilation, room
units, internal heat gains and setpoints.

3% DA ICE 47 beta

File Edt View Insert Tools Options Window Help
D-F-B-& ia@d 2¢ 03| % /mdd BLp  GR OSEEEaN
— 72 Zone s sonein uiding? =~
Insert new object v @ | | General Advanced | Outiine | Resuits|
i o poomnet 0] open oo Pin_| &
Open Floor P + . -
b Occupant Number of zones of this type @ to ceiling - o0 — E@@@\i
g E;I:Ipmem Loss factor for thermal bridges wrc @ o seet e,
==~ Internal masses 1 controller setpoints [local for zone] [<]¥ Floor height 00 |m
= Wall mass above ground LR
% Corwec.tws intemal mz " oom Units
-~ Room units
2 Ideal cooler Central Air Handling Unit More... Ed Ideal cooler
& Ideal heater [air Handling Unit [=] & Ideal heater
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e. InIDA ICE, you can choose between two different zone models. The little simpler model is
called the "Energy” model. The more detailed model is called the “Climate” model. The
"Energy” model is a bit faster and suitable for Energy calculations. But to calculate e.g. the
Fanger comfort indices and operative temperatures at certain positions in a room, you have
to use the Climate model.

To select the zone model, one goes to the Advanced tab of the zone form:

r Advanced Parameters Domestic Hot Water Use
Number of occupants
Model fidelity |Defauh - Average hot water use =
v | Default upant and day : 1
Zone group | Climate
*C); find further details in Plant and Boiler;

Air velocity in the e Energy Jtionally, aiso be defined on the building level ]
occupied zone -

Distribution of hot water use
[e uniform [+][»]

[The curve is automatically rescaled to render given average total usage]

Zone controller ‘<contmlled by setpoints> E

[Optional central controller for all zone devices, such as blinds, heaters, VAV etc ]

Inuse |<when occupied> E]

The ’In use’ signal is available to controllers. ‘In use’= 1 indicates that the zone
should be ready for occupancy (even if there is no actual occupancy.)

r Description

Note: Which of the two models is the “default” model, can be defined in the main General
tab by clicking on o Defaults

Note: The “Climate” model is limited to show box zones. Whenever the “Climate” model is
selected for more complex zone geometry, IDA ICE will give a warning at simulation start and
use the Energy model instead.

f. In IDA ICE, you can navigate through the 3D view (here the zone model) as follows:
e rotate by clicking and holding the left mouse button.
e zoom in and out by clicking and holding the right mouse button and moving up-
wand downwards.
e Pane by clicking and holding the middle mouse button or scrolling wheel
(alternatively left and right mouse button at the same time)

Try to rotate and zoom to the following view:
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Step 3

a. Open the external wall without window by double-clicking on it in the 3D view. You will then
get the form of the zone surface.

Note: The zone surface is always shown from the inner side. The origin point for coordinates
always on the bottom left corner of this view.

In the side bar, you can switch from “Properties” to ”"Palette” and back by using the two
buttons on the top. The palette gives a list of all objects that can be inserted to the active
view. Observe how this palette changes when switching from the zone to the surface form.

b. Dragand drop a window from the palette to the wall surface:

& A
Fle Edt Yiew [noen Tools Options Window Help
D-s-d-& B|oe/ DO % mE-d BEp|aw OBa
Prupertis | Fane =
Insert new object vl e S [@ =
-+ Fenture General Agvancea Outine Results
T Caving daica enerat Soom neignt 0
W Eisctre radiator Open Floor Pian X %y y Tz
I Water Radiator Number of zones of this typs [1 & 19 ceiling [26 |m
;E“‘” gicosiing panel [l Wall & an enclesing slement in IndClim-MyEx Zone [E=RE=R =
jpening

P ] Sutace Advanced Outine

E Window |N
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& Leak

& Wall part
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e
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Layer
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| | | | Walld Ext. 104 Buid.. 2700 %0 [Defa.. 05372 027 Render  0.01 We. 025 Render 0.1

Note: There are two different window objects — “Window” and "Window (detailed)” — that
can be inserted. These two objects are related to two different window models. Here, we use
the standard (more simple) window model.

c. You can now change the size and the position of the window by either moving the whole
window or its borders/corners, or by editing the geometrical parameters in the ”Properties”
view of the side bar.

Model your window to be 1.5 m high and 2 m wide. The sill height should be 0.5 m and the
horizontal distance from the external corner to the left border of the window 1 m.
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Double-click the window (either in the 3D view of the zone form or the 2D view of the
surface form) to open the window form. Here you can give all window properties as e.g. the

relevant glazing values, how and when the window should be opened, solar protection
properties and frame U-value.
Load the ”Blind between panes” from the IDA ICE database by following the clicks in the
picture below. You can then close the forms for window and zone surface.

€ ndClim My 1DA Indoor Chmate and Enengy B Csers\laggia0iDesktop\BasicCourse Indoor Cimate of 2 single zone,
File Edit View Inset Tooks Options Window Help

O-E-d-& ¢

Window
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R
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T e === e
General Geometry
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- Integrated Window Shading
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— pen...
Control [5un @) open v '
Schedule pa New resource..
e - & Load oo from dalabe 5l X
Type [No extemal shading <] | Mepping 9 p
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Mode|
= — — |Dncnw|Muniphel‘ Mumpiilr‘ Multip!m| "
Control [pa I an forg | forT
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Control [Never open B0 El Medium dark, tightly woven drape 04 on o
hedul ‘” a ‘ > B Medium dark. lightly woven drape. 062 0.26 0T v
© New resource
= e || Name [525ma Bew 18RL5) \
ote... ind between panes
T, BT e i
Ualie wimzg) ([T f
[]
 Object :
Name  Window Jarmsable
Description. [indow O The o rsourcs b
protected Change the.
o v Ok [y Cancel Hele name ta remove the protection

Note: the alternative data input is done from a dialog. A dialog differs from a form in that
way that you need to close it with the “OK” button in order to save your modifications, while

in forms changes are always saved automatically and immediately.
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As we started our new IDA ICE model with the default building, the inserted zone already has an
"ideal cooler” and an “ideal heater”. This is to directly be ready for a cooling or heating load
calculation without specifying the room unit type that will be installed. But to calculate the thermal
comfort of a room, the type of the room units is relevant and the results significantly depend on it.

a.

We thus delete the existing ideal heater and cooler by marking them one after the other and

either click the "delete” button or selecting "delete” from the context menu. The context
menu of an object is opened by right clicking on the object.

/r} Zone: a zone in building2
General | Advanced I Outline I Results

r General

Number of zones of this type
Loss factor for thermal bridges wre

focaorzone) —<]0)

l Controller setpoints

Room height
@ to ceiling

€ to roof

Floor height
above ground

[E=5E=R =)

. bee) o
o m
e
o m

Central Air Handling Unit

Room Units
Ideal coole] Open..

b. We can now insert the specified room units. In this lesson we will use a water radiator for
heating and an active beam for cooling, as both is often used in typical Swedish office

buildings.

Insert a water radiator below the window of the western facade. You can do this from the
zone surface as we did with the window. Position and size of the radiator is shown in the

picture below.

|Ai1 Handling Unit ]El [ Ideal heate Open with
System type CAV n Open with form...
Open with new form ‘
Supply air for CAV L/(s. m2 Rename...
Return air for CAV U(s.m2, R Convert to resource... -
Displacement degree for Q Light |
gradient calculation D 0-1 b Occupant E“‘
Ec & Copy
Leak area 307E4 | m2 &8 Equip o @
Given additional in/exfiltration [0 | L/(s.m2 ext. surf)
— Replace...
@ Surfaces s ® o 7 Air units 7) Leaks ~) Room units ) Internal gains () Internal masses [
Name T Wetted |Connecte| Azimuth,| Slope, |Construct| U-value, | Thicknes| Layer t !‘?ye’ Layer i ].alxyer Layer thilz:akyr ]
Ype area, m2 dto Deg Deg ion Wi(m2 K] s, m material ”"'“;r': material ”“'";r': material i
B Elnnr Int flnnr 40N Nana nn Mafa PEYT n4178 Flanr nnng AN~ nno Ponce NAE
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Size your water radiator by double-clicking on it to open its form. Click on the button for
alternative input data and give 600 W. Normally you should find the design power and design
condition of your radiator in the manufacturer’s data sheet.

€ IndClim-MyEx - IDA Indoor Climate and Energy @ CiUsers\loggi30\Desktop\BasicCourse Indoor Climate of  single zone\
File Edit View Inset Tools Options Window Help
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S Supply temp at
b I» e power L DR | Ues C
Return temperature TiOut [45 DegC
atmax power
Massflow at full power 001433 | ko

T

In the water radiator form you can also select the controller type. We leave it at proportional
controller. The proportional band is 2 °C by default and can be defined in the system

parameters that are accessible from the main General tab by clicking on.
Ml System parameters

We can now close the water radiator and the zone surface form.

The last thing which is relevant for thermal comfort are the zone setpoints. Open the zone
setpoint dialog by clicking on 1 controller setpoints in the zone form. For temperature
setpoints, give 21°C and 25°C. Click "OK” to close the dialog and save your changes.
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AsBE st smcn semoe AAR L2800 socs smcn

General

Supply air for CAV

Retum air for CAV
Displacement degree for
gradient calculation

Leak area

1 Floor

Number of zones of this type D

Room height
& to ceiling
€ to roof

," [ oy ) o =
[

Control Setpoints

Max

Mech. retum air flow

Relative humidity
Level of CO2

M - O
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heating
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The control action of heating and cooling depends on
the controller used in the actual device. Defaults are P
control for radiators and Pl for most other room units.

* when both VAV and other means of cooling have
been defined, VAV is used first and setpoints of other
room units are offset by 2.0 "C. (Change globally in
System Parameters)

[<value not set> :|j

Step 5

[] Ceiling

= Wall1 Int. wall Min
= Wall 2 Int. wall

- o

b

[cvalue not set>

BC

Name

[local for zone]

Description I

[

J

Save as...

J(

Heip

We are now ready to run a heat load calculation in order to verify whether our radiator has the

appropriate size.

a. First of all we select the results we want to look at. Go to the Simulation tab and click on

[ Requested output . Select the zone level diagrams ”Main temperatures”, ”Heat balance”,

"Fanger’s comfort indices” and ”“Indoor Air Quality”. Click “OK” to close the dialog and save
your changes.

10
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General Floorplan 3D  Simulation Daylight Outline Summary Details

Project name  IndClim-MyEx 0) IR st of output objects o
i - Building Level ——————— - Reports - Building Level
Eﬂeﬂuﬁl&dwim 9 ¥ AHU temperatures ¥ Delivered Energy
' Simulation data J ™ AHU air flows I™ Log sources
I Plant temperatures ™ Log detailed sources
¥ Total heating and cooling I Log per energy carrier L
™ Wind speed ™ Lost work
) ™ Plant details ¥ AHU energy
& Setup
. ™ Occupancy I™ Log sources
Cooling load B3 setup ™ Log detailed sources
W Input data report
Energy # Setup
Refel fi fo
Overheating W Setup ra;wr;nce porsrestor m?
All (above) Diagrams - Zone Level —————————— . - Reports - Zone Level
o ¥ Main temperatures @j ¥ Energy
Custom — Setup F Heat balance F Log sources (energy table)
T Air temperatures at floor and ceiling” I Log detailed sources | .
N Level ¥ Fanger's comfort indices I Log sources (transmission table) | IR
 Indoor Air Quality I~ Log detailed sources
(Y Build model FYEdit I” Daylighting [T Thermal comfort (EN-15251, with cooling)
I™ Directed operative temperatures* ™ Thermal comfort (EN-15251, without cooling) P

I Air flow in zone

™ Airbone heat flow into zone
™ Surface temperatures

I” Surface heat fluxes

™ Convective heat fluxes

I Ventilation air flows

™ Shading control

™ Occupancy

In addition, any model variable can be logged at the Advanced level Find instructions here .
* Only available for ‘Climate’ zone model fidelty. See Defaults.

E @)Cancel Help

Click on & Setup for Heating load to select the simulation properties related to heat load
calculations. Use a fixed ambient temperature = -15°C and 0 solar radiation. Click “Run” to
start your simulation.

Soacarees ST T A

File Edit View Insert Tools Options Window Help

Project name  building2
Results
Requested output Select Heating load calculation
€ Fans off &2 simulating the system building2,
Heating load = Sﬂﬂﬂ (@ Fans according to their schedules, Supply 16.01.2015 00:00:00
Coviing load - Sﬁo temperatures according to defined AHUs Calculalion phiass, period 4 260,00
. P J Internal gains [ |
nergy Setup 30
Percentage of internal gains D % a0
All (above) 20
Custom 2, Simulation data Weather
Y " @ Use synthetic weather —_—
FEnsbl cosimuizion ([N siove s namser sour | [
Use fixed ambient -10
o [15__ ] oe B
ffy B B9 Edt " Design period using climate file -
penedusig s Qutsicle i dry-bulb temperature
[ra -1 Return air dry-bulb temperature
e Supply air dry-bulb temperature
L |
[ PR ]
y ) [ Cose (o ]
@) [7|Close this window afer simulation

After the simulation, the Summary tab is opened automatically. This result table (for Heat
load calculations) shows maximal power and temperatures at maximal power. As we now did
a heat load calculation with static boundary conditions, we can also expect static conditions
within the results. Check the room units heating power and room air temperature.

11
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€0 IDA ICE 47 beta

File Edit View Inset Tools Options Window Help
D-@-H-8 sp@ 90c D80/ md BLp G OaRERCA

General | loc-CH | Fioor plan | 3D | simulation | Daylight | Outiine | Summary | Details |

© Heating

Zes [ Expand table
Zone | Heat Room Ontom Max Sup Sup Ret |Other sup)

Zone Group |multip| supplied, Time unit heat,|Temp., °C p, P C02, | airflow, | aitemp, | aiflow, | airflow,
[ =) L we S 'S |pmean ve | e | us | ue
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Step 6

We want now continue with a Cooling load calculation. To do so we first insert the cooling room unit.

a. Open the zone form and insert an active beam to the ceiling. Double-click the active beam
and set design cooling power to 800 W at 20 L/s as well as 30 W at 0 L/s. Leave the controller
at Pl what effects that the cooling power is adjusted in order to hold at most 25 °C as long as
the provided maximal cooling power is sufficient. Leave all other parameters at the default
values and close the active beam and the ceiling form.

€ IndClim-MyEx - DA Indoor Climate and Energy @ C:\Users\loggi30\Desktop\BasicCourse Indoor Climate of a single zone\
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Guide — Indoor Climate

b. Check the ventilation settings in order that supply air flows should meet the requirements of
the active beam.

& IDAICE47 beta
File Edit View Insert Took Options Window Help
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General Advanced | Outine | Results|

General Room height
Number of zones of this type [:l € to ceiling
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c. The ventilation supply temperature is set in the air handling unit. Open the air handling unit
from the General tab and check the supply temperature that should be set to 16 °C by
default. This temperature is by default raised by 1 °C through the radiator resulting in 17 °C.

£ IDAICE 47 bets ——
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Step 7

Next is to define the internal heat gains that normally are very relevant for the cooling load.

Open the zone form and look at the list of “Internal gains”. There are 3 different types of internal
heat gains: Occupants, equipment and lights. Occupants are positioned on the floor, lights are
positioned to the ceiling. Lights do also have a geometrical length and width. Equipment does not
have a position in the zone. You can drag in multiple internal gains from each type or delete them
separately from the list.

& IDAICE 47 beta
file Edt View Insert Took Options Window Help
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a. Open the occupant load by double-clicking on it. Set the number of people to 2, Activity level
to 1.1 met and clothing to 1 + 0.1 clo. For the occupancy schedule you select “load from
database” and choose ”08-17 weekdays”.

6 Occupant: a group of eccupants in building2.Zone El ==
Number of people in group
Schedule |© 08-17 weekdays EE]'
sy e
r Clothing
& Constant O J#01 ] *cLo
€ Schedule |n,a —| >

[*clothing is automatically adapted
between limits to obtain comfort]

- Object
Name Occupant

Description

b. We now adapt the occupancy schedule by clicking on Schedule and then clicking the button
”Save as...”. We chose the name ” 08-18 weekdays with break 11.30-13”, adapt the
description and click “OK”. Define your schedule according to the figure below by ”"dragging
the blue profile lines. Click ”OK” to close the dialog and save the changes.
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T e e e
Name 08-18 weekdays with break 11-13 B0l Name [08-18 weekdays with break 11-13 B0
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o0 T 0 ] 12 ‘% is s 2 ¢ 0% 3 G ] 3 3 (o 2 EQ
Saturday - Saturday 0

10 10

05 5
[ 53me 3 Mon-Fri ] 8ame as Mon-Fri

% 3 g g i T T 2 E s 3 5 g Z B T 7 ™
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( oK | [ saeas. |[ cancel |[  Hel Advanced... ! oK ][ saeas. || Cancel |[  Hei Adanced..

c. Open the floor of the zone and mark the occupant. You can change the position of the

occupant object (consisting of 2 persons) by either drag and drop of the occupant icon or by

giving the coordinates in the "Properties” part of the side bar. Position your occupant as in

the figure.
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d. Now doubleclick on Equipment in the Internal gains list of the zone form. Give 2 units with 75

W each. And change the schedule to the one defined before. You will refind it in the

dropdown-list. Look at all other parameters but leave them on default.

Also test the help function by clicking on K? and then onto the equipment form.

i bulkiing2.2:
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You can now close the equipment form.
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As you did with the other internal gains, open the light and give 1 unit with 60 W. Also select
the control strategy “Setpoints AND Schedule”. This means that the light will be controlled

according to daylights as long as the schedule allows it. As the schedule is ”Always on”, we
will have lights during the whole night.

=
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Open the ceiling to see where the light object is positioned. Adapt the size to 1x1 m and

place it approximately to the center of the room.
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Guide — Indoor Climate

We can now run the cooling load calculation to study the summer comfort. The climate is according

to the selected location.

Go to the main General tab and select Vasteras by selecting "Download”, clicking on ”S” for
”Sweden” and scrolling down to the correct station. Then click “OK” and ”Close”.
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File Edit View Inset Tools Options Window Help
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Open the location form by clicking on EM and study the data that can be given here.

Close this form without modifications.

u Location
Location | © Vasteras/Hasslo Afh_024460 (ASHRAE 2013) =0
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Object
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Description Data from ASHRAE Fundamentals 2013

-

Cancel Saveas... Help
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b. Go to the Simulation tab and open the Setup for Cooling load calculation. Use all default

settings and click “Run”!
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Study the results in the Summary tab and compare the table values with the diagrams in the
Details tab. Unselect the two diagrams “Total heating and cooling” as well as "AHU
temperatures” and select the zone diagrams “Main temperatures”, "Heat balance” and
"Fanger’s comfort indices” instead.

Use the duration diagram type to find

o the number of hours with operative temperature greater than 26 °C

e the number of hours with PPD (percentage of people dissatisfied) greater than 12 %
The figure below guides you to do this.
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